
Emma Harris // Operations Director

Welcome

In this issue//

The process improvement company

Firstly many apologies that this edition is so late, I do 
hope our bumper summer issue gave you plenty to 
keep you interested while you were waiting.

Triaster has had an extremely busy and productive 
summer, completing the Simulation and Aggregation 
development for release this month and delivering 
some very interesting implementations in the USA. 

Another pleasing aspect of the summer was the 
response to Microsoft’s annual survey to ensure that 
Triaster should retain our Gold Partner status. The 
results were excellent, with 98% satisfaction returned 
and all results well above the benchmark. This is 
absolutely what Triaster strives for, in fact the teams’ 
reaction was, ‘What went wrong with the 2%?’ 

It was also great to receive some very encouraging 
comments about the Connector, ‘I love the current 
Triaster newsletter. It is very informative and to the 
point.’  ‘Excellent.’  ‘Relevant and insightful.‘ I hope we 
continue to hit the spot with this edition. 

Others asked how to receive it electronically and how 
to stop receiving it twice in their in-box. The answers 
are; to receive the Connector electronically please go to 
www.triaster.co.uk/connector and complete the form at 
‘Register Now’. To ensure that you only receive it once, 
please click on the ‘Unsubscribe’ link at the bottom of 
one of the Connector notification e-mails.

emma.harris@triaster.co.uk               +44 (0)870 402 1234

Your Success is our Success
Being a Trusted Partner.

WebLog Expert
Getting the most from it - part two.

T.U.G. (Triaster User Group) News
Register for the next meetings.

Triaster Software Development
The latest features and planning
for the future.

Tech News
Configuring Visio and Process
Navigator in the Registry.

Meet…Steve Odeyemi
Project Support Consultant.

Events Explained
Why you should attend.

Community Events
Keeping you up-to-date.

From the Community 
What a great summer!

Page 2

Page 7

Page 14

Page 9

Issue 12 // September / October 2013

Page 5

Page 16

Page 20

Page 22

Page 17

mailto:emma.harris%40triaster.co.uk?subject=


Join the discussion at www.triaster.co.uk/connector

www.triaster.co.uk/connector

Call us on +44 (0)870 402 1234

Your Success is our Success

Triaster understand that our customers’ success is our 
success and our model is to align our services to ensure 
that we deliver it.

Over the summer, Triaster delivered two very different 
projects – although in fact both were in the USA. 

Whilst the services delivered and the structure of the 
implementations were very different, working as a 
trusted partner to deliver on each customer’s objective 
was, as ever, Triaster’s over riding aim.

The larger-scale project of the two was delivered to 
Homeserve USA, and included providing professional 
services to map out the current state processes across 
four value streams of the global services company, for 
population of a new Triaster Process Library.

Homeserve’s previous experience of consultants 
had caused some doubts amongst some of the 
stakeholders as to whether the project should include 
external consultants. Their concerns were mainly 
around whether the consultants would integrate 
effectively with the project leads and also whether 
knowledge gained during the project would be lost 
once the consultants left site. Triaster met with the 
relevant stakeholders to assure them that the Triaster 
consultants would be ‘trusted partners’ in the project 
and actively engage with everyone involved in the 
project to ensure knowledge gained would be retained 
internally.

Once the delivery scope was agreed, three Triaster 
consultants were quickly deployed (within about a 
week) to two stateside locations.

Each Triaster consultant was assigned a value stream 
with the fourth value stream assigned to an internal 
Business Analyst supplied by the organisation. Each of 
the four value streams was further defined by Level 1 
and Level 2 processes.

Being a Trusted Partner
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Tight timescales were set, as 100% of the “AS IS” 
processes across the four value streams had to be 
mapped and validated by the process owners within 8 
weeks.

The approach taken by the Triaster consultants to meet 
the tight timeframe was as follows:

1.	 Provide an on-site author training and governance 
workshop to internal business analysts, global leads 
and supporting staff.

2.	 Provide joint presentations to key stakeholders in 
the business about the project objective and the 

The US project to map Level 1 and Level 2 
processes in just eight weeks was, by any 
standards, a challenging brief but that did 
not deter the joint Triaster and
Homeserve team.

With the scope agreed, the project was 
mobilised and immediately set about 
working with Subject Matter Experts and 
Process Owners to document and validate 
the end-to-end ‘AS IS’ processes. Key to 
the successful delivery of the project was 
the effective integration of the Triaster 
consultants and Homeserve teams. 
Homeserve has now engaged Triaster to 
undertake a similar exercise in the UK and I 
have every confidence that we will deliver 
another great result.

Andy Walls, Global Lead – Business Process
& Change, Homeserve
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solution use in the short and long term.
3.	 Identify Process Owners and Subject Matter Experts 

for each Level 2 process.
4.	 Set up process discovery workshops with the 

Subject Matter Experts (SMEs).
5.	 Map out the Level 2 process including any 

improvement opportunities identified during the 
discovery workshops. In addition, the consultants 
collaborated with individuals on a separate internal 
improvement project to dovetail with the processes 
captured as part of that project and avoid any 
duplication of effort.

6.	 Work with the SMEs to validate the processes and 
make any amendments to the process maps if 
required.

7.	 Work with the Process Owners to validate the 
processes and make any amendment to the 
processes if required.

8.	 Track and report on progress daily to the Project 
Lead.

9.	 Link end-to-end processes together across the four 
value streams highlighting any gaps.

At the end of 8 weeks, 96% of the processes were 
mapped, validated and readily available in an on-
line, live Triaster Process Library. 

The remaining 4% of the processes were mapped 
but not validated because they were in a state of flux, 
between the ‘AS IS’ and ‘TO BE’ status; otherwise 100% 
validation would have been achieved.

Processes were linked end-to-end across the four value 
streams and improvement opportunities were instantly 
available in a report. Responsibility and Accountability 
were captured against each Activity as well as
systems used.

There is a complete audit history of the processes 
using Triaster approvals workflow. Microsoft Excel Data 
Managers were used to populate Node properties 
rapidly such as SMEs, Process Owners, Change 
Descriptions, Review Dates, etc. across multiple 
processes. Data Managers were also distributed to 
the SMEs during the validation period in case they felt 
other improvement opportunities could be added to 
the processes. 

Once the project library was established, it was cloned 
and given to the internal improvement project team to 
be used as the basis for their on-going work. Internal 
project staff were trained to facilitate their own process 
discovery workshops, mapping processes using Process 
Navigator in real time during discovery meetings and 
administration of their Process Library.

The second project delivered this summer was in 
partnership with Bluehawk Consultancy in Seattle. 
Triaster and Bluehawk worked seamlessly to provide 
a rapid Process Library deployment for T-Mobile 
(USA). As with many projects, discussions began in 
March, however priorities were changed and the 
implementation was put on hold.

In July, priorities changed again and the 
implementation was needed within a couple of weeks. 
Triaster was able to move fast, and working around 
global time challenges, established a plan to implement 
the system and deliver training on site, in Seattle 
alongside Bluehawk consultants, by the 22nd August. 
This was exactly 6 weeks from establishing the project 
requirements, and because of IT restrictions and project 
team availability, the solution was in fact implemented 
and the project team trained in just 6 working days.

Our strong partnership with Bluehawk Consultancy 
added great value to this implementation and ensures 
on-going local support to T-Mobile.

Bluehawk Consulting is one of the leading 
management consulting firms in the West 
Coast of USA.  We have been working with 
Triaster in support of our customers in the 
USA for the past five years. 
  
Throughout our engagement with Triaster, 
they have proven to be a dependable, 
reliable, and responsive partner.  In our 
latest engagement with T-Mobile USA, 
Triaster has gone above and beyond 
the call of duty to ensure a successful 
deployment of the Triaster solution.  
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Paul’s shortcut of the month  
F12 gives a ‘Save As’ option in all Microsoft 
applications

Customer Tip
If you make your hyperlink label 100% 
transparent, it will then appear as a description 
when you hover over the link in HTML

Triaster was there to support our ever 
changing needs as our client went through 
a process of acquisition, integration, and 
IPO impacting our engagement timeline.
      
Triaster’s proven process management 
solution and their wealth of process 
management knowledge complements 
our skills and activities, providing 
an additional and valuable market 
opportunity for us and our customers.

We have found the Triaster solution to be 
an excellent fit with the Business Process 
Improvement services we provide.  Triaster 
allows our customers to easily automate 
their business processes to improve the 
efficiency of their organization. Triaster is 
a well-established firm with an impressive 
track record for delivering results. They 
have been an excellent partner for us.

I want to thank Triaster for all the support 
you have given Bluehawk as we grow 
our partnership.   We look forward to our 
continued partnership as we expand our 
presence throughout North America.

Zach Hopkins, Bluehawk

Live from linkedin

Linda Spinks, University of Cambridge asks 
the Triaster User Group how they currently 
link to SharePoint Documents.

http://tinyurl.com/Lindas-Qu 

From the Twittersphere

It’s lovely to receive feedback on Twitter:

BIA Services attended our “Making 
the Most of Process Mapping” 

Seminar. For more details and to 
register for these events please go 

to www.triaster.co.uk/events
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WebLog Expert 
Part two on how to get the best from it

In part one we looked at how we may interpret combining a number of reports together to inform the 
Library Administrator or Manager which maps, files and documents users access in their Process Libraries, 
which in turn provides an insight into user trends and behaviour.

WebLog Expert also has a number of other features of interest to Library Administrators and Managers 
who need hard data to present to Senior Management to support their business cases or change 
proposals. This can be found by viewing ‘Activity Statistics’ which report daily, weekly, monthly statistics. 
Also ‘Access Statistics’ reports on user viewing time, entry and exit pages, file paths, and visitor statistics. 
These reports provide a storyboard of Process Library user behaviour. 

Top Host – Computer IP or ID

The ‘Visitor Statistics’ report enables Administrators to see who in their organisation uses their Process 
Libraries; this is reported by computer IP address - see image above – listed in order of the most active 
computers. Also available are the entry or landing pages users start from within the Process Library and 
also which pages they exit from. Put this together with the viewing times and we have a clearer picture 
of whether users are finding what they are looking for, or become frustrated and abandon their search 
midway. 

On the flipside, we have statistics reporting how many users prefer to use Triaster’s Quick Search feature 
to find maps and documents. One client with whom I met raised an interesting point about the use 
of Quick Search. They were reviewing the culture within their organisation and decided it would be 
good practice for Library users to fully understand where their processes fit within the wider scope 

Steve Odeyemi // Project Support Consultant

If you missed
part one of this article

you can download it here:
www.triaster.co.uk/connector
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of their organisation and function units. This client felt that users should be familiar with using the full menu 
path structure to get to process maps and documents, before using Quick Search. They felt that otherwise the 
users wouldn’t gain a better understanding of where their process sits in relation to other processes within the 
organisation, functional unit and sub-groups. On the other hand, some companies are excited by the increased 
number of users finding their maps and documents in two to three clicks. 

In addition, WebLog Expert allows Library Administrators and Managers a glimpse of some security metrics 
provided by the ‘Errors’ report. This reports the number of unauthorised external users outside of their 
organisation. Unauthorised users who are denied access to Process Library site(s) receive one of the following 
Windows messages: 403 Forbidden, 404 Page Not Found or 503 Service Unavailable – see sample chart below. 
To further improve access security, should it be required, Triaster is happy to collaborate with any client’s IT 
department.

For more information, please contact the Triaster Support Team on 0870 402 1242 or at support@triaster.co.uk.

If you already use WebLog Expert or any other analytical tool with your Process Libraries and would like to share 
how you use it, please go to www.triaster.co.uk/connector and click on ’Connect’.

In Steve, I’ve rarely come across a trainer so completely engaging and thoroughly 
professional while maintaining a personable and accessible approach. …He handled 
the issues with consummate ease and confidence, never once losing my attention 
or me as a participant. Overall; the staff involved, the environment, the course 
materials, equipment, approach and content all contributed to this being one of, no, 
to this being THE best training experience I have come across. 

James Macleod, office2office
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T.U.G. News
Linda Spinks presents the latest news from the User Group

Linda Spinks // User Group Chairperson

The User Group in action at Openfield.

User Group

The next User Group meeting will be
hosted by 3663 at their Manchester
site in Salford, on 9th October 2013.
There are a few spaces left, so if you
would like to attend please book on
via the website here: www.triaster.co.uk/events 

For reference, the minutes from the last meeting, 
which was hosted by Openfield in March, along with 
presentation slides and the current Product Roadmap 
can all be found via the User Group Secure page at: 
www.triaster.co.uk/usergroup/ 

Please e-mail customer.services@triaster.co.uk if you 
need a reminder of the username and password to 
access this area.

Also, please do remember that if 
you have any general questions 
that you’d like to ask other 
Triaster users, the User Group 
Forum on LinkedIn is the ideal 
place for this. The more people 
who use it the more useful it will 
become. This forum can be both 
clicked to from the User Groups 
Secure page and via this link:  
http://tinyurl.com/pv5vnkp  

If you aren’t already a member of this group, please 
simply request to join and the group owners will 
approve your request.

Education Group

Following feedback earlier this year, it has been 
decided to hold an annual Education Special Interest 
group meeting for those of you who find value in 
meeting up with colleagues across different education 
organisations. The objectives of the group will be 

WE TELL
YOU

The next User Group
meeting will be hosted by 

3663, Manchester
on 9th October 2013.     
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reviewed and decided upon at the next meeting. 

Martin Fey at the University of Bristol has kindly agreed 
to host the meeting, and through consensus the date of 
this meeting is 29th January 2014. 

If you would like to offer to host a meeting please drop 
us an e-mail with some suggested dates to
user.group@triaster.co.uk 

If there are any customers who would like
to arrange an alternative Special Interest
group, whether it is for industry specific
reasons or another common area that
you’d like to workshop and discuss with
others, please feel free to suggest it.
These meetings can be one-offs or ongoing and Triaster 
are happy to assist with any arrangements required and 
also attend the meeting, if that is useful.

user.group@triaster.co.uk

YOU TELL
US
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We would not have got to where we did 
without the absolutely fantastic support 
we have had from Triaster. I know I must 
have been the bane of your lives at times 
with my constant e-mails asking what 
probably seemed like the most obvious 
and simple questions. You have all been 
brilliant, have the patience of saints and I 
can’t thank you enough for that. I’m sure 
there will still be plenty more questions 
and look forward to our continued 
relationship.

Project Lead on Go Live, multinational 
corporation.

The current level of service Triaster 
provides is outstanding so would be very 
difficult to improve in any area, but they 
somehow do, keep it up.

Steve Ward, NG Bailey, Microsoft survey

I would just like to thank you for all the 
support you have given both myself and 
BAE and I’m sure our paths will meet 
again. On a personal level I will miss our 
conversations, I wish you well for the future 
in business and your personal lives.

Martin Sainty, on leaving BAE
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Triaster Software Development

New features available now

Process Navigator – version 13.4

Process Simulation and Automated Data Aggregation have been released in 13.4 as a Feature Preview. As 
a reminder, Feature Previews are first releases that are targeted at expert users in order to enable expert 
assessment of the capability and the user interface to it. Feature Previews are well tested but may be light 
on end user documentation.

Simulation and Aggregation can be switched on in Tools > Options > Feature Previews, which then 
enables the new Simulation and Aggregation menu. 

As a reminder, the July/August Connector set out how Simulation
and Aggregation drives process improvement (page 11). There
will be more on this in future Connectors.

Triaster Server – latest version 13.4

Alerts and Approvals have been further improved in 13.4 with the following enhancements:

•	 Map review reminders are now able to be sent at set periods before the review date is due, for 
example three weeks before the Next Review date and then again at one week before.

•	 The Next Review can now be populated automatically when a map is approved. On each 
approval, the Next Review date will be set to a date in future, for example, 6 months from the 
approval date. If, for example, a particular map needs to be reviewed more frequently, the date 
can be set on a per map basis.

•	 Approvers who have maps awaiting approval are no longer sent a new e-mail every time the Pre-Live 
site is published. Instead, the e-mail will only be sent when the map has changed; for example, when 
the map has been submitted for rework or a subsequent approval.

News on the latest functionality, events and future plans

Andrew Ridgeley // Senior Software Engineer

Process Navigator 13.4
can now be

downloaded from: 
http://knowledgebase.triaster.co.uk/Home

9

Please contact
customer.services@triaster.co.uk

to discuss your Library
upgrade.
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Mobile Devices

An outline design had been produced by Triaster and 
this was discussed, as follows. Some details may change 
as the technical design process proceeds. 

1.	 There will not be a separate mobile library; instead 
additional interfaces or components will be added 
into a customer’s current Process Library.

2.	 The Mobile Devices project will be introduced in a 
phased approach. This will enable the development 
to concentrate on the highest priority areas first 
(finding and using process maps). Therefore, the 
first phase will focus on Search capabilities and 
publication format of the maps.

3.	 An additional set of published html will be 
produced from the Visio maps. These will use a 
format such as png, which will be cross-browser 
compatible. The left hand pan and zoom window 
and Ctrl + Click properties window will not be 
present but hyperlinks and OPCs will work. The 
published maps will use a narrow cut-down nav bar 
to increase available screen space.

4.	 It will be possible, using the nav bar, to switch 
between the standard published map and the new 
format published map. This will enable users to 
select which version is most appropriate for them at 
any particular time. 

5.	 A new Search interface will be created. This is likely 

Customer Focus Day: Planning for the future

The last Customer Focus Day was held on 11th July. 

Sessions with Andrew Ridgeley included Mobile 
Devices, the new web-based Configuration Interface 
and enhancements to Alerts and Approvals 
functionality. The main points of these discussions 
are given below.

In addition, Mike Cousins demonstrated 
improvements to Data Manager as well as Simulation 
and Aggregation. Much of the feedback from this 
session has been integrated into the new feature.

James Harvey and Ashwin Jayapaul demonstrated 
the Triaster Server 13.1 and onwards upgrade 
process, to highlight how simple it is to perform a 
self-upgrade.

Our requirements have been met at every 
stage of our journey so far and have always 
been met with an open yet informed and 
considered response.

Susan Grinnell, Spirax Sarco, Microsoft survey

Jo Dolton oversees proceedings at the Focus Day
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to be a simple interface with, for example, a search 
text box, a Go button and the search underneath. 
This could be set as the user’s homepage to allow 
quick access to process maps. It will be possible 
to switch between this and the existing search 
interface.

6.	 A new cross-browser compatible homepage will be 
available as an alternative to the Flash home page. 
An online demo of a sample page can be viewed 
here (http://www.triaster.co.uk/triaster_mobile/v1/
home/menu.html).This design demonstrates how 
the elements resize and reposition according to 
screen size, so we’d recommend you view this on a 
phone as well as desktop.

7.	 Maps that are available via mobile devices will need 
password protection.

It is anticipated that some of the features discussed 
above will be available in version 13.5, with further 
enhancements rolling out in subsequent releases.

Software Development Events

Triaster Solution Update -
15th October 2013

A demonstration and discussion of all the new Triaster 
Suite features released throughout 2013, including all 
features released in version 13.4. We look forward to 
welcoming you to our Wallingford offices for this event.

Maximising the use of your latest 
upgrade - 14th November

If your Library has been upgraded to Sever 11 or above, 
come to this workshop at our Wallingford offices, next 
being run on 14th November. It is a very practical day 
covering all the different configuration options and how 
they may best support your objectives.

‘I found the session really helpful…thanks very much.’ 
3663
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Customer Focus Day - 4th December

The next Customer Focus Day will take place in 
Wallingford on Wednesday 4th December. We are still in 
the progress of planning the agenda but if you have any 
topics you’d like to discuss please contact:
customer.services@triaster.co.uk.

Release Update Webinars

As you may be aware, 
we recently took part 
in a Microsoft Survey 
as part of our Microsoft 
Gold Partnership 
renewal, from this we 
received feedback from 
our overseas customers 
stating that they would 
love to be more involved 
in Triaster events.

So, as a first step we have set up a 
number of webinars at various times 
to ensure that everyone has an 
opportunity to attend:

Tues 1st October 2013	 8:00am to 9:00am BST
Thurs 3rd October 2013	 5:00pm to 6:00pm BST
Wed 27th November 2013	 10:00am to 11:00am GMT

All events are free of charge to attend. Please book early 
to avoid disappointment!

Web Interface for Configuration Settings

A new web-based interface for editing the 
configuration settings was demoed. This is currently 
in production and is expected to be released in the 
medium-term future. This has the following advantages 
over the current Pub Server Config Utility tool.

1.	 There is no need for direct access to the web server.
2.	 The settings are divided into logical functional areas 

such as Alerts, Reports or Toolbar.
3.	 It will be possible to update a setting at a global 

level (i.e. all sites and all libraries) while still 
retaining the flexibility to have a different setting 
value at site level.

4.	 The interface is built using HTML5 which allows full 
cross-browser compatibility. The screen elements 
will re-position intelligently depending on screen 
size, allowing the pages to be viewed using a 
Smartphone or Tablet.

For more details and to 
register for these events 

please go to
www.triaster.co.uk/events

 Please book early
to avoid disappointment!
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Alerts and Approvals Feedback

The following features were regarded as high priority 
for future releases

1.	 Layout improvements (such as stopping the 
heading scrolling on the Maps for Approval screen).

2.	 Allow comments on Approval.
3.	 Ability to customise text in alerts (customisation of 

look and feel wasn’t a priority). This feature will be 
released in 13.5.

Product Roadmap Update

It was explained that following the on-line feature 
prioritisation meeting in June, the Product Roadmap, 
now has a top 10 feature section for both Process 
Navigator and the Triaster Server, setting out the 
priorities agreed. 

The feature prioritisation process was discussed and the 
following points were raised/agreed:

1.	 Feature Prioritisation calls should take place every 
six months.

2.	 An easier to use response form and/or an online 
voting system would improve the process. 

3.	 It would be useful to show the complexity of each 
feature in terms of development work (for example, 
easy, medium or hard).

4.	 It would be useful to have visibility on what is in 
development and when the expected release date 
is.

One of the high priority Server feature requests was a 
tool to check the integrity of broken links. It is unlikely 
that Triaster would develop software to do this as there 
are a number of tools available to purchase which can 
check for hyperlinks. A demo was given of two such 
tools:

•	 Screaming Frog
•	 Deep Trawl

Both of the tools can be installed onto a PC or laptop 
with access to the Process Library (typically a Library 
Administrator’s machine). 

Multi-Year Contracts -
a reminder

Triaster offer reductions on Agreement 
renewal costs to all customers making a 
single payment of multi-year renewals. 
These are usually based on 3 or 5 year 
renewals and not only do you benefit from 
the reduced cost and price protection over 
the term of your contract but all Benefit 
Credits are made available immediately. 

A multi-year renewal can be arranged at 
any time, so if you are looking to bring your 
renewal in line with budgets and/or know 
what your requirements are likely to be over 
the longer term, please contact Jo Dolton on 
customer.services@triaster.co.uk in order to 
gain further information.

The service we have received from Triaster 
in developing our process mapping 
solution has been exceptional.

Anonymous response, Microsoft survey
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Tech News
Configuring Visio and Process Navigator in the Registry

Visio and Process Navigator can be configured through their user-interfaces, but particularly when 
deploying Process Navigator to numerous users, making those settings directly to the Registry through a 
REG file or a script can be quicker and ensure a consistent set-up. We have a template script that requires 
just a little tweaking to make it applicable to a customer’s set-up. Do let us know if that would be of 
interest.

These are common Visio configurations and their related Registry settings. Note that these are all user-
specific, and wouldn’t require elevated permissions to apply.

Visio

File Locations
Visio 2003, 2007: Tools > Options > Advanced > File Paths...
Visio 2010: File > Options > Advanced > File Locations...
 

John Blight // Technical Support Manager

Setting
Drawings

Stencils

Templates
 

Registry Setting 
HKCU\Software\Microsoft\
Office\<Version>\Visio\Application
DrawingsPath (REG_SZ)

HKCU\Software\Microsoft\
Office\<Version>\Visio\Application
StencilPath (REG_SZ)

HKCU\Software\Microsoft\
Office\<Version>\Visio\Application
TemplatePath (REG_SZ)

Values
Typically, the main location in which maps 
are stored, e.g. \\TriasterServer\Triaster\
TriasterServer2011\MapStore\Process 
Library\Sandpit Maps

This could be a shared location on the 
Triaster Server, e.g.
\\TriasterServer\Triaster\TriasterServer2011\
MapStore\Stencil, Template and Properties
Multiple paths can be specified, separated 
by semi-colons. The Process Navigator 
installer will add the ‘Templates and 
Stencils’ folder within the Process Navigator 
installation.

This would be the same location as for 
stencils.
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File Format
Visio 2003, 2007: Tools > Options > Save
Visio 2010: File > Options > Save
 

Setting
Default format 
– SaveVisio 
files as Save 
documents – 
Save files in this 
format
 

Registry Setting 
HKCU\Software\Microsoft\
Office\<Version>\Visio\Application
SaveFileFormat (REG_SZ)

 

Values
The Visio XML Document (VDX) format is 
required by Process Navigator.
SaveFileFormat = 2

 

Security

Macro Security
Visio 2003: Tools > Options > Security >
Security Level
Trusted Publishers

Visio 2007: Tools > Trust Center > Macro Settings
Visio 2010: File > Options > Trust Center > Trust Center Settings… > Macro Settings
 

Setting
Security Level
Macro Settings

Trust access to 
the VBA project 
object model
 

Registry Setting 
HKCU\Software\Microsoft\
Office\<Version>\Security
Level (REG_DWORD) (Visio 2003)
VBAWarnings (REG_DWORD) (Visio 
2007, 2010)

HKCU\Software\Microsoft\
Office\<Version>\Security
AccessVBOM (REG_DWORD)

Values
It’s important that Visio on a Triaster Server 
does not prompt with macro warnings, 
as that would stall an automated, non-
interactive publication. On a server, we 
recommend macro warnings are set to the 
lowest level.
Level = 1 (Visio 2003)
VBAWarnings = 1 (Visio 2007, 2010)

This needs to be enabled.
AccessVBOM = 1

More Information

This article is available in more detail from our Knowledge Base, including configurations for Process 
Navigator, and with a template script.
http://knowledgebase.triaster.co.uk/help-for-it-administrators/installation/configure-visio-process-
navigator-registry



Join the discussion at www.triaster.co.uk/connector

www.triaster.co.uk/connector

Call us on +44 (0)870 402 1234 16

Meet Steve Odeyemi

Steve joined Triaster earlier this year, immediately fitting in 
so that it already seems as if he has been with us for many 
years. He is working across the entire customer journey, from 
supporting prospective customers with their evaluation of the 
Triaster Solution to delivering training and project support to 
current customers. His role at Triaster builds on his previous 
experience of delivering and supporting technical solutions 
for customers including Vodafone, Unipart and Sainsburys 
and of course he has had the full support of the Triaster team. 
However we are sure it has been quite a learning curve. We 
asked him to reflect on his first six months at Triaster, what he 
has enjoyed the most, what he has found most challenging 
and what he brings to the role. 

Part of my role involves setting up prospective clients’ 
evaluation sites and content. So far this role has brought 
me in contact with a number of interesting organisations 
including existing clients, who are ready to take the next step 
with the Triaster Solution.

I have had a number of opportunities to visit clients’ sites to 
review their Process Libraries and I have enjoyed using my 
technical knowledge to resolve some outstanding issues 
and queries whilst there. This in turn has enabled me to 
see first-hand how each clients’ Process Libraries have been 
customised and also how their requirements vary. This has 
been really interesting, especially seeing how different 
organisation use their Process Libraries to implement change 
and improve efficiencies, often in very difficult areas of their 
business.  Another project I have been involved in has been 
the testing of the new Triaster Simulation and Aggregation 
features, released in PN version 13.4. The recent Data Manager 
function, which I have already demonstrated to a number of 
clients, works together with the Simulation and Aggregation 
to create an end-to-end process cost, by aggregating activity 
costs vertically and horizontally across a process. Really 
exciting!

It’s been a great six months which has flown by. I look forward 
to the next six months, especially meeting and getting to 
know more clients.

Been working with Triaster since 
2013

Before that
Contractor at OZD Technology Limited, Milton 
Park, Abingdon.

Professionally he is most proud of …
Learning to gain expert knowledge and stay on 
the leading edge of the curve.

Hobbies
Reading, Films, Kitcars, Chess
and Squash.

Likes
Anything to do with a
positive healthy lifestyle.

Dislikes
Snakes and insects 
that bite.

Everyone at Triaster will
always remember…
He wears really great
shoes on dress-down days.

Project Support Consultant 

Fact File
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We have recently received feedback that suggests there may be some confusion over the purpose of the 
different events we run. Therefore we thought you may find it useful for the most regular events to be 
explained in a bit more detail as follows:

Customer Experience Exchange

This is a half-day event at which three Triaster customers each give a case study presentation about their 
implementation of the Triaster Solution and what they have achieved - sharing lessons learnt along
the way.

Triaster User Group

The Triaster User Group meetings are held twice a year and are hosted by customers who are happy to 
provide an insight into their business and how they use the Triaster Solution. The day is about getting 
together with other Triaster users and sharing thoughts, ideas and feedback. There are usually one or two 
group workshop sessions on subjects decided on the day by the group, and a Triaster update session.

Events Explained
Jo Dolton and Emily Constance explain why you should attend

Jo Dolton // Customer Relationship Manager & Emily Constance // Business Operations Manager 

Why should I attend?
To network with other customers, be updated on the 
Triaster Solution and get involved in discussions that 
may help you with your role/project.

Why should I attend?
For a fabulous networking event and to learn more 
about what other organisations have achieved with 
the Triaster Solution and how they have approached 
their Business Systems, Process Mapping and 
Improvement projects. 

17
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Triaster Education User Group

This a Special Interest Group for members of the main User Group who are in the Education sector. The 
group has decided to meet once a year to discuss Education specific topics relating to the use of the 
Triaster Solution and associated BPM work.

Focus Day

Triaster holds several Customer Focus Days a year during which Andrew Ridgeley, Triaster’s Senior 
Developer, holds several workshop sessions. These are for direct discussions with and feedback from 
Triaster customers on what you want to see in the Solution and how you want it to work. Other members 
of the team also run discussion sessions as appropriate.

Solution Update Event

This event focuses on demonstrations of all the new features released over the previous 12 months.

Why should I attend?
If you work within in Education you will meet up
with other like-minded users of the Triaster
Solution, in order to share ideas and best practices to 
address objectives and issues that are sometimes very 
specific to this industry.

Why should I attend?
This is your chance to get involved in the early 
discussions around new and existing Feature 
Development. Some sessions are at the specification 
stage and others provide an update on current 
development, asking for early feedback on features 
already underway.

Why should I attend?
If you have missed any of the previous launch events 
and update webinars, or would just like an update, 
you will find it useful to see these new features in 
action, meet up with other customers to hear their 
thoughts and talk further with Triaster.

Setting up Industry Specific User 
Groups is open to all customers. 

Please contact
customer.services@triaster.co.uk 
if you would like assistance with 

setting up a group.
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Process Mapping Seminar

A half-day seminar held at various locations around the UK in order to provide an introduction to how 
process documentation can be Useful, Usable and Used.

Public Training Course

This two-day course is an introduction to Process Navigator and process mapping using the Triaster 
Solution. Over the duration of the course you will walk through the basics of Process Navigator and the 
methodology used as well as touching on some of the more detailed features.

Technical Workshop 

A workshop designed for IT or technical Library Administrators who wish to
gain an insight into the workings and more technical side of the Triaster Solution. 

Why should I attend?
These events are for anyone with little or no prior 
knowledge of the Triaster Solution and the mapping 
methodology we use. The seminar sessions explain 
how Triaster deliver a successful and useful business 
management system.

Why should I attend?
For a good basis of
knowledge of how
to use Triaster software.

Why should I attend?
If you have a specific IT contact that owns the Triaster 
Solution/or you have access to your server and would 
like a better understanding of the self-upgrade 
process, talk to Triaster about arranging to attend one 
of these workshops.

You can sign up
to receive e-mail updates

on events here:
www.triaster.co.uk/connector/register.php



Join the discussion at www.triaster.co.uk/connector

www.triaster.co.uk/connector

Call us on +44 (0)870 402 1234
20

Community Events
Jo Dolton & Emily Constance review the upcoming calendar

Jo Dolton // Customer Relationship Manager & Emily Constance // Business Operations Manager 

Triaster and our customers host a number of events as listed below. Many of these events are free of 
charge to organisations with a Trusted Partner Licence Agreement. Of course, all Triaster training courses 
can be delivered on-site, if you would like to discuss this further, please give us a call:
+44 (0) 870 402 1234 or e-mail customer.services@triaster.co.uk

Date What is the 
Event?

Who benefits from 
attending?

How will I benefit? Location

1st Oct 2013
3rd Oct 2013
27th Nov 2013

Release Update 
Webinars

All Triaster 
customers

An executive briefing from the Triaster Team 
looking at new features from Triaster, what’s 
happening in the Triaster Community and what’s 
coming up next.

Webinar

9th Oct 2013 Customer User 
Group

All Triaster 
customers

A great opportunity to meet customers from a 
variety of industries and share your views and 
experiences of Triaster. “Come along to our 
lively and interactive User Group meetings and 
gain an opportunity to influence future Triaster 
developments as well as getting to know some 
like-minded people.” Linda Spinks, University of 
Cambridge, User Group Chairperson

3663, 
Manchester 
Depot, 
Salford

15th Oct 2013 Triaster Solution 
Update

All Triaster 
customers 

This event will provide a demonstration of all 
new features released throughout 2013 including 
the Simulation and Aggregation features, 
as discussed in the July/August Connector 
Newsletter and due for release in 13.4.

Triaster HQ, 
Oxfordshire

21st & 22nd Oct 2013*
9th & 10th Dec 2013
20th & 21st Jan 2014
5th & 6th Mar 2014

*Now fully booked

Triaster 2 Day 
Training - 
Creating Maps For 
Your Library 

Anyone needing 
to map their 
processes

This training course covers the basic software 
skills needed to create process maps with Process 
Navigator and publish them to your Library. “The 
whole course was useful. I have been busy with 
Triaster for some 6 months - and I finally get the 
concept...before that I was just messing about 
really...”

Triaster HQ,
Oxfordshire

6th Nov 2013 Customer 
Experience 
Exchange

Existing Triaster 
customers 
and potential 
customers from all 
sectors

Each Triaster customer has a different experience 
of working with the Solution. Both existing 
and potential customers frequently say how 
beneficial it is to hear and discuss how other 
customers are working with the Triaster Solution. 
That is what this event is about - three very 
different customers share their experiences.

“ The diversity of use is encouraging. Thoroughly 
enjoyed this event, thank you.” SQA 

Triaster HQ, 
Oxfordshire

mailto:customer.services@triaster.co.uk
mailto:customer.services@triaster.co.uk
http://triaster.co.uk/connector_events_user_group.php
http://triaster.co.uk/connector_events_public_training.php
mailto:customer.services@triaster.co.uk
mailto:customer.services@triaster.co.uk
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Date What is the 
Event?

Who benefits from 
attending?

How will I benefit? Location

14th Nov 2013 Maximising the 
Use of Your Latest 
Upgrade

All Triaster 
customers on 
Server 11 or above

Now that you have had a chance to try out your 
upgraded Library, come along to understand the 
different configuration options and how they 
may best support your objectives.

“An excellent way of learning how to get the 
most out of my upgrade.”

“Great for understanding the new features I 
received as part of my upgrade.” Xtrac

Triaster HQ, 
Oxfordshire

4th Dec 2013 Triaster Customer 
Focus Day

Project Leaders 
interested in 
influencing the 
development of 
Triaster software & 
services

Customer Focus Days give the opportunity to 
workshop with Triaster development regarding 
both software and services and directly influence 
and impact the end results.

“A golden opportunity  to influence the 
development of the solution to deliver on your 
company objectives” Skanska

Triaster HQ, 
Oxfordshire

29th Jan 2014 Education Special 
Interest Group 
Meeting 

Triaster customers 
in the Education 
sector

Meeting users in the Education sector who 
are able to share, understand and solve each 
other’s problems with process in this particular 
environment.

University of 
Bristol

Dates available on 
application

Triaster Training 
- Technical 
Workshop

Library 
Administrators, 
IT and Support 
professionals

The workshop answers in-depth all of the 
commonly asked technical questions about the 
Triaster Server installation; as well as providing 
plenty of opportunity for delegates to discuss 
their own systems.

“I would recommend the workshop as it gives 
the attendees a good insight into how all the 
elements of Triaster piece together.” Rob Fletcher, 
ING Direct

Triaster HQ,
Oxfordshire

Dates available on 
application

Triaster Training - 
Process Discovery 
Facilitation  

Anyone 
responsible for 
process discovery

Training that covers the skills and approaches 
that will enable you to successfully facilitate your 
Process Discovery workshops. (Triaster can also 
deliver on-site Process Discovery workshops.)

Triaster HQ,
Oxfordshire

Not to be missed! 
The next Customer Experience Exchange will be held on 
6th November 2013.  Make sure that you attend ! 

For more information and registration for this and 
other Community Events please go to:

www.triaster.co.uk/events.php

21

As a company they strive to provide an 
excellent working relationship with the 
client - there is no negative feedback
I can offer.
Anonymous response, Microsoft survey

http://triaster.co.uk/connector_maximising_upgrade_workshop.php
http://triaster.co.uk/connector_events_public_focus_day.php
http://triaster.co.uk/connector_events_special_interests.php
http://triaster.co.uk/connector_events_technical_workshops.php
http://triaster.co.uk/connector_events_process_discovery.php
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Summer 2013

Lots of people have been doing fun 
and fantastic things over the summer, 
so we thought it would be great to 
share some of them with you:

A big congratulation to Julie Mack, 3663, who 
recently got married. We wish you and your new 
husband all the best for the future. 

James Harvey, Triaster, took part in Dragon Boat 
racing on behalf of the charity SeeSaw, winning 
three out of four races. 

From the Community
Latest news and discussion

Send us your news!
We love to include your news in the 

Connector. Please e-mail
customer.services@triaster.co.uk, or 
just mention it next time you call in. 

Would you like to feature your project 
in one of the main Connector articles? 

Just let us know.

 

Susan Grinnell, Spirax Sarco, faced two big challenges 
this summer. Not only did she compete in a Triathlon, 
but the following weekend she completed a half 
marathon too! Well done Susan, you are an inspiration 
to us all.

Karen Walker, Triaster, has been taking part in a 
number of rowing races over the summer.

mailto:customer.services%40triaster.co.uk?subject=
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Guess who competition – the Answer

We asked: ‘Can you guess which member of the 
Triaster Team is in this photo and the character 
they are dressed as?’

Believe it or not, this 
is Paul Elson-Vining 
dressed up as Gene 
Simmons! We received 
some weird and 
wonderful answers as 
well as a few correct 
answers. 

The winner, picked at 
random is…

Steve Staunton
from Interserve Defence. 

Congratulations a £15 
Amazon voucher is

on the way.

‘Triasthletes’

Mike Cousins, Triaster, completed an Olympic length 
Triathlon in three and a half hours, raising over £500 
for Diabetes UK. Congratulations Mike, we are all very 
proud of you but wondering what you will do next?

Not to be left behind, Emily Constance and Victoria 
Glancy, Triaster, will be taking part in the Oxford Half 
Marathon in October. Emily will be taking part on 
behalf of local charity ‘Friends of O.S.C.A.R’ and Victoria 
will be running just for fun! We wish them both luck 
and look forward to an update in the next Connector 
Newsletter.
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Q Tucker, Fugro GEOS, went on a holiday of a lifetime to celebrate his wife’s

birthday. Here are some of his photos from his safari adventure in Zambia.

24

And finally
Q Tucker in Zambia

Q Tucker // Library Administrator, Fugro GEOS
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